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Basics

Send messages via S! Mail or SMS.

S! Mail Exchange text messages with SoftBank or e-mail compatible
[Separate handsets, PCs, etc.; attach image or sound files, etc.
subscription | ® 842P is compatible with Graphic Mail (C%P.14-5) and
required] AutoArt (C%P.14-7).

SMS Exchange short text messages with SoftBank handsets.

® For more information, visit SOFTBANK MOBILE Corp. Website
(http://www.softbank.jp).

IAvaiIabIe Entry Items & Character Entry Limits

@ Character limit varies with attachment size.
® SMS can be converted to S! Mail while creating a message (C5P.14-8).
® S! Mail cannot be converted to SMS.

I Messaging Folders & Memory Status

Messages are organized in folders by message type.

Messaging Folders

Incoming Mail

1-4=71)% 1-3°

Receive Messages —

! SoftBank handset numbers only
2 When text entry mode is set to English (160char.) (CP.17-19), up to
160 single-byte alphanumerics can be entered.

14-2° Up to 300 KB including subject, message text and attachment

Item S! Mail SMS "= === =9 Spam Folder
E-mail o B - Create Messages
2 | address Up to 246 single-byte Save as Drafts
% Phone alphanumerics/ Up to 21 single-byte
2 | rumber | C | UPto 20 recipients | O | alphanumerics/Up to Send Messages Sent/Unsent
1 recipient Complete/Not complete? I—). | Sent/Unsent |
Up to 256 double- - - :
== 1-H-T 55 1-3°
Subject O byte/ — —
Up to 512 single-
byte alphanumerics ! Set Auto-sort messages to specified folders or Spam Folder automatically
Lle to 70 double-/ (C%P.14-17,P14-18).
Text O | 30KB O | single-byte . 2 When handset is out-of-range or in Offline Mode, outgoing messages are
alphanumerics saved as Unsent until signal becomes available (C%P.14-3).
Attachment O3 — — 3 Add up to ten user folders (C%P.14-21).



Auto Resend

When handset is out-of-range or in Offline Mode, unsent S! Mail and

SMS are saved as Unsent and protected from auto deletion.

When signal returns, messages are automatically sent. Once sent,

messages are unprotected.

® To cancel Auto Resend: C%P.14-22, P.14-23

® When Auto Resend (C%P.17-18) is set to OFF, unsent messages are
not automatically sent.

Deleting Messages Automatically
When memory for messaging folders is low, old messages are
automatically deleted one by one. Protect important messages from
unintentional deletion (C%P.14-22, P.14-23), or set Auto Delete to OFF
(C5P.17-18). Messages in Drafts and SMS in USIM Card are not deleted
automatically.

When Messaging Memory is Full
& (Received Full) appears in Standby and no more new incoming

messages are received. Delete unnecessary messages in Incoming Mail
box (C%P.14-22, P.14-23), then retrieve new messages (C3P.14-16).

I View Memory Status
> — Memory Status

P eccccccccccccocccccccoe
@Mail Security (C3P.12-11)

I Customizing Handset Address

Change your handset mail address (alphanumerics before @)
to reduce the risk of receiving spam. Default account name
is random alphanumerics.

abc123-xyz @ softbank.ne.jp
L Account | | Domain _]|
Name Name
(Customize here)

® For details, visit SOFTBANK MOBILE Corp. Website
(http://www.softbank.jp).

@ Handset mail address cannot be changed in Offline Mode.

® For operations while using Internet: C%P.15-6

1 — Settings —» Custom Mail Address

Handset connects to the Network.
Follow onscreen instructions.

buibessa\ ;
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Sending S! Mail & SMS

I Sending S! Mail

® Text entry: [¥P.3-2

Example: Select a Phone Book entry to send S! Mail.

1 Pressand hold

Attachment field
Text field

2 Select Address field =
Phone Book

3 Select a Phone Book entry =

Select a SoftBank handset number
or mail address

® Press (9 to toggle tabs if both mail
addresses and phone numbers are
saved.

New S! Mail
<Add_Address>

New S! Mail
B <Add_Address>
B Destination Address
[iPhone Book ]
ElSent Address
ElReceived Address
EIMail Group
BlAddress Input

6 Enter text

FAPhana Mumhar Tnnut

Phone Book

v S5 0EL®
Abe Ichiro

JAoki Taro
090XXXXXXXX

ITkeda Jiro
Ishikawa Saburo
Ttoh Shiro

4 Select Subject field - _ e SLlail

Enter subject

5 Select Text field

4

~IAdd Art [Preview
Text Entry Window

7 [Send] -t ewSl Mai |

I an fine as usual.

® Alternatively, Main Menu » Messaging » Create New or
—» Create New to open Composition window




P eccccccccccccocccccccoe
@Addresses (CP.14-8)
@Additional Functions (C%P.14-9)
@Sending Options (C%P.14-11)
@D @Hide Outgoing Message Window (C5P.17-18)
@Set Reply-to Address @Set Signature (C3P.17-19)

Adding Attachments

New S! Wail

1 After Step 6 on P.14-4, select
Attachment field

2 Select a folder = Select a file

Long time no see. How
lare you doing?
1 an fine as usual.

3 [Send]

this Saturday?

[ Capture Pictures/Videos to Attach

> After Step1, Activate Camera — Photo mode or Video mode —
Frame subject = (@][Record] or (0D (— For video, (@][Stop] or (0)
— (@)[Save] or (0))

® Some files can not be attached depending on the file format or size.

® Some copy protected files can not be sent.

® Attachments of 300 KB or larger are automatically compressed (Width
and height of compressed images may change). If the compressed file
still exceeds maximum size, message cannot be sent.

® Ring Songs&Tones, Music and Videos files cannot be attached directly
from microSD Card. Move files to handset before attaching to messages.

P eccccccccccccocccccccoe
@Attachments (C%P.14-9)
T @Disable Auto-Compression of Image Files (C%P.17-19)

Graphic Mail

Create HTML messages; select font color/size, background
color, or insert images, etc.

Example: Use a template to create Graphic Mail.
® Change font size
® Scroll text

1 After Step 4 on P.14-4, (¥7)[Menu] - Load Template
— Highlight a template = (=2) [View] = (@) [Select]
® To return to Template list:

Select Text field = Delete C CICXEBALWN TR !

W/ NextPage 4

buibessa\ ;
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—» Font Size

® Alternatively, () [Menu] -
Set Graphic Mail to open Graphic
Palette

Select a font size = Enter text

—> Select area

Place cursor before a sentence
to scroll = (@][Start] = Move
cursor to end of sentence =

(®)[End]

Text is highlighted.
@ To cancel selection: (@)

Set Scrolling — () [Exit]

[4] to preview =

® Alternatively, () [Menu] =
Preview to view text field

(@)[Set] = (=)[Send]

1),

~|Context “Preview
U

o5 |

E A AlA G

Font Size
[R130115/307208d

dbe e

Graphic Palette
B

Edit Preview

[ Reset Operations

> To cancel previous operation: Close Graphic Palette - (37)[Menu] —
Undo

> To reset all Graphic Mail operations: — Graphic all reset = YES —
YES

M Use Mail Art
> In text entry window, —» Mail Art = Select an item = (37)[Exit]

M Use Files Saved in microSD Card
> In text entry window, — Insert files = File Select —» Select a
folder — (&) [microSD] —» Select a folder = Select a file

P eccccccccccccocccccccoe

@Use Other Graphic Mail Settings @Download Templates via Internet
(5P.14-10)



AutoArt

AutoArt converts S! Mail to HTML mail and automatically
adds pictographs and background color.

@ To change font color by AutoArt: £%P.17-19

® To change font size by AutoArt: C5P.17-19

1 After Step 6 on P.14-4, AutoArt — Select an item (See

below)
Item Description
Automatic Automatically adds art.
Happy, Sad, Like,  Automatically adds art corresponding to the

Angry or Surprised selected mood.

Converted message appears.

@ To cycle next/previous selections: (7) [Next]/ (=) [Prev.]
@ To cancel and return to Composition window: —»

2 (©)iset] » [@)[Send]

@ Alternatively, (i) [Menu] —» AutoArt in Composition window after
entering text

@ Use AutoArt to automatically add art in Graphic Mail.

@ AutoArt cannot be canceled after pressing (@)[Set] in Step 2.

P ecccccccccccccccccccoe

GITTD @Set Preference for Amount of Pictographs in AutoArt @Disable
Background Color Function (AutoArt) (C%P.17-19)

I Sending SMS Messages
® Text entry: [¥P.3-2

Example: Select a Phone Book entry to send SMS.

> -
1 Address field —-TorEX NI

Create New SMS e W<Tnput Text> |
Text field —[

Composition Window

Select Address field = New SH5

Phone Book

Destination Address
[ilPhone Book ]
ElSent Address
ElReceived Address
Eldirect Entry

W/ NextPage 4

buibessa\ ;
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3 Select a Phone Book entry —» Phone Book

Select a SoftBank handset number

Abe Ichiro
@ Aoki Taro

090XXXXXXXX
ITkeda Jiro
Ishikawa Saburo
Itoh Shiro

4 Select Text field

5 Enter text

® \When number of entered character
exceeds limit, S! Mail conversion option
message appears.

6 [Send]

dc/ [R170/700w]
Hode Set Henu
Line FD

Text Entry Window

M Converting to S! Mail
> In SMS Composition window, (7)[Menu] = Change mail type

® When a single-byte text message including | {} [ ]~/ is sent or a draft
including such symbols is edited, some characters at the end of text
may be cut out.

® Alternatively, Main Menu > Messaging » Create New SMS to

open SMS Composition window

P ecccccccccccccccccccoe
@Addresses (C3Below)
@Additional Functions (C%P.14-9)
ITITD @Hide Outgoing Message Window (C%P.17-18)
@Change SMS Center Number @Set Input Character to English
(CFP.17-19)

I Creating Messages

Addresses

((From Jp Composition window, select Address field

M Enter Address Directly

> SI Mail: Address Input or Phone Number Input — Enter a mail
address or SoftBank handset number

> SMS: Direct Entry —» Enter a SoftBank handset number

M Select Address from Sent Address/Received Address Logs
> Sent Address or Received Address — Select a log = (@][Select]

I Select S! Mail Address from Mail Group
> Mail Group — Select a Mail Group



[ Add/Edit/Delete S! Mail Address
> Follow the steps (See below)

Item Operation/Description
Add > <Not entered> —» Search/enter address = Select an
address or enter directly = (=) [Finish]
Edit > Select an address = Edit = Edit address
— (=@)[Finish]
Delete > Highlight an address = (37)[Menu] -

Delete receiver & YES — (=)[Finish]

® To edit SMS address: Select Address field — Direct Entry —» Edit phone
number

M Change To/Cc/Bcc (S! Mail Only)
> Highlight an address = (x7)[Menu] — Destination types — Select a

type —» (=)[Finish]
Attachments

((From B After attaching a file, select Attachment field

M Open/Play Attached Files
> Select a file = After viewing file, — [=2)[Finish]

M Add Attachments
> (x7)[Menu] — Add Attached Files — Select a folder — Select a file —
(=)[Finish]

® To capture still images or videos to attach: C%P.14-5

M Delete Attachments
> Highlight a file = ()[Menu] — Del Attached Files - YES
— [=2)[Finish]

Additional Functions

I Functions Available in Composition Window
> In Composition window, (37)[Menu] — Select an item (See below)

Item Operation/Description
Send Send message
Preview Preview message
AutoArt' (C5P.14-7)
Save as Save message to Drafts box without sending
Drafts
Attached View attached file list
files'
Load (c%P.14-5)
Template'
Save Save edited template
Template' > YES
Add Add signature
Signature' ® (reate and save signature beforehand (C%P.17-19).
Send (C¥P14-11) 14
Settings'
Image Set whether to compress attached files automatically %
Compression' > ON or OFF g
Confirm (C%P.14-11) Q,
Delivery’ a
Input Select character input mode

character? > Japanese or English

Change mail  Switch SMS to S! Mail
type’

!SI Mail only
2 SMS only

14-9
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I Graphic Mail Functions

[ Use Other Graphic Mail Settings
> In S! Mail text entry window, — Select an item (See below)

Item Operation/Description

Alignment > Select a type

Item Operation/Description

Insert files Insert still images, music or Flash® files; activate Camera
and insert captured image
Music files are sent as BGM
> Select an item
- File Select — Select a file type —» Select a folder
—» Select a file
- Camera —» Frame subject = (@)[Record]
@ To delete inserted music files: Delete BGM —» YES
Font Color > Select a font color
Background > Select a background color
color
Insert Lines  Insert a separator line
Mail Art Insert Mail Art
> Select a file
Graphicall  Cancel all Graphic Mail Settings
reset > YES
Selectarea  Specify text to be arranged
> Place cursor before/after text = (@)[Start] =
99 to highlight area = (@)[End] — Select other
items —» Follow the steps for selected items
@ To cancel selection: (@)[End] = (@)
Font Size > Select a font size
Select Flash text
Blinking
Set Scrolling  Scroll text

Set Swinging Swing text

14-10

® One file of music or Flash®, and up to 40 types of My Pictograms or
images can be inserted per Graphic Mail.

® To delete inserted images, lines, Mail Art, etc.: Close Graphic Palette —»
Move cursor before images, etc.

@ Ring Songs&Tones or Music files cannot be inserted directly from
microSD Card. Move files to handset beforehand.

I Save Edited Templates
> In'S! Mail Composition window, () [Menu] = Save Template —
YES

M Download Templates via Internet
> — Templates = Download Templates — YES
@ Handset connects to the Network. Follow onscreen instructions.



I Sending Options

(From Jp Composition window, ()[Menu]

M Confirm Delivery
> (For S! Mail, Send Settings —) Confirm Delivery = ON
® Request Delivery Confirmation (C%P.17-18)

I Notify Recipients of Priority Level (S! Mail Only)
> Send Settings —» Priority — Select a level

[ Set Reply-to Address (S! Mail Only)
> Send Settings — Set Reply-To - ON
® Specify reply-to address beforehand (C3P.17-19)

Receiving & Viewing Messages

Retrieving S! Mail Automatically

Auto Retrieval downloads complete messages and any attachments.
Transmission fees are incurred according to subscription.

® To disable Auto Retrieval: C¥P.17-19

I Opening New Messages

When a new message is received, i g
incoming mail window appears, SR s U Ul
then [ and Event Indicator appear in
Standby.

(58 1A= (F7)

- @ect
R

i F Revd. Msg.
Select Event Indicator T TRTRD

Newest message appears. [From Suzuki Goro

; [suBHel lo
@ Press (99 to show previous/next message. CaliNo Attachment File

Long time no see. How
lare you doing?

I am fine as usual.
By the way, can we
have lunch together
this Saturday?

Message Window

—
buibessa\ =
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® [f an incoming S! Mail has more than one recipient, select Display
Address in Message Window to view recipient list.

@ Handset may connect to the Network via URL link in message text.
Data-intensive web pages may incur high charges.

® Incoming message window may not appear; message tone and
Notification Light may not always sound/illuminate. However, (4 flashes
when receiving a new message.

@ Event Indicator disappears even when an unread message other than
latest message is selected.

P ececcccccccccccccccccoce

@Retrieving/Viewing Messages (C5P.14-16)

@Setting Secret Mail (CFP.12-11)

@ITTD @Change Ringtone @Change Ringer Volume @Set Message
Ringtone Duration @Set Vibration Alert (C%P.17-2)
@Set Notification Light by Incoming Type (Voice/Video Calls or
Messages) ((¥P.17-9)
@Hide Incoming Message Window while Other Function is Active
@Hide Sender Info in Incoming Message Window (C%P.17-18)
@Limit Auto Retrieval by Message Type (C¥P.17-19)

14-12

I Window Description

M Messaging Folder Contents

Received

Received Date/Time!',

Sender? and S! Mail Subject
(For SMS, Message Text)

@ For Sent/Unsent box, following

6/24 Suzuki Goro
od_evening

6/24 Shirato Hanakol
Hov are you? |

appear:
' Sent date/time Example: Received Folder
2 Recipient in Incoming Mail Box
Message Type/Status
Message Type Message Status
/ ) Unread/Read S! Mail s Attachments
= | @ Unread/Read S! Mail & (Silver) Protected

Notice
52 / ) Unread/Read SMS
L. | @ Unread/Read USIM

Forwarded Message

|

Replied Message

Card SMS Failed” .
= Forwarded Server Mail Resend S.cheduled
[Z] New Delivery Report*
I High Priority
& Low Priority
M

*Messages in Sent/Unsent box only



I Message Contents

Sent/Received
Date & Time
Sender/Recipient
Subject

No./Total Number
Sent or Received

Revd. Msg.

]

Message Text

this Saturday?
Message Window

Number of Attachments
The number of files (images, sounds, videos, text, etc.) appears.

@ Status indicators for forwarded/replied SMS messages (saved in USIM
Card) do not appear.

® After retrieving complete messages, S! Mail Notice icons with

(Forwarded) or =[] (Replied) change to (=1/ (® (S! Mail).

® Messages remain protected after complete messages are retrieved via
protected S! Mail Notices.

® |f messages on microSD Card do not appear correctly (C3P.10-19), copy
messages to handset (C%P.10-20) and execute Charset Conversion
(C5P.14-24).

P eccccccccccccocccccccoe
@Functions Available from Message List ((3P.14-21)

@Functions Available in Received/Sent Message Window (£%°P.14-23)
D @Change Font Size ((¥P.17-18)

I Retrieving Complete S! Mail

The complete message may not be downloaded during
handset operations. Center sends initial portion of message
as an S! Mail Notice. Manually retrieve the complete
message.

Select continue at end of
S! Mail Notice

[L@2010/6/24 10:15
[From Suzuki Goro
[SuBlHel lo

[ @No Attachment File

Long time no see. How
lare you doing?

I am fine as usual.

By the way, can we

have lunch together
ithis Saturday?

How about 12 o' clock at

@  Rcvd. Msg. 4/8

the rest
continuel
Reply Menu
Page & 2 prgew

M Retrieve from Message List
> In received message list, highlight an S! Mail Notice = (7)[Menu] -
Retrieve —» This one

M Retrieve Multiple Messages

> In received message list, highlight an S! Mail Notice = (37)[Menu] =
Retrieve — Selected —» Check S! Mail Notices = (=) [Finish] =
YES

—
buibessa\ =
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I Opening & Saving Attachments

i
1 In Message window, ) [E12010/6/24 10:25 ]
[Menu] = Attached files i Function  2/3
sEliSend Ir data
. [LEIC Transmission
2 Select a file By to wicras)
C
File opens or plays. EUIS]
P play é)ﬁ”a” Information
3 After viewing, W8l coched files |
Attached files window returns. I3 [Add Shortcut Icon
Highlight a file to save —» el
4 Highlight a file to save it

Select

[Save] = YES —> Select a
folder

® When messages are opened, attached image files open/play
automatically.

o = (Silver) appears with file requiring a Content Key. If Content Key has
expired, warning appears when opening a file. Acquire new Content
Key (C%P.10-5).

® Incompatible files are saved to Other Documents in Data Folder. Some
files may not be saved to handset.

=
™
w
w
v
Q
S
@

P eccccccccccccocccccccoe

File Formats Supported by Auto Playback
® |mage files: JPEG, GIF, PNG
® Music files: SMAF, AMR, SMF, SP-MIDI

@D @Play Attached Music Files Automatically (C%P.17-19)

14-14

I Showing Sent/Received Mail Address

Sent Address
Press and hold (o

Received Address
Press and hold o)

- SMS (successfully sent)
- S1 Mail (successfully sent)
® To show Redial/Incoming Call Logs: (@)[Change]

) Selectalog to view details
® To send S! Mail/SMS to recipient shown: (@)[ <] — Compose
message (S! Mail: 3 From Step 4 on P.14-4 or SMS: C¥From Step
4 on P.14-8)
® To save to Phone Book: (&) [Store] —» Operation for saving to
Phone Book (C%From Step 2 on P.4-5)

P eccccccccccccocccccccoe
@Sent/Received Address (C%P.14-20)



I Using Server Mail

Retrieve mail list stored at the Center to view Server Mail.
Viewing Server Mail List

1 — Server Mail

) Retrieve Mail List = YES

M Update Server Mail List
> After Step, Retrieve Mail List - (=) [Update] = YES

Retrieving Server Mail

1 —> Server Mail = Retrieve Mail List
@ [f no Server Mail is in the list, YES & OK

2 Retrieve a New Message
Select an S! Mail

Retrieve Multiple Messages
[Menu] = Retrieve = Retrieve Selected —
Check messages — (=2 [Finish] —» YES

I Retrieve All Messages
> (=) - Server Mail — Retrieve All

Deleting Server Mail
1 —> Server Mail — Retrieve Mail List
2 [Menu] = Del Server Mail

Delete a Message

Delete This = YES

Delete Multiple Messages
Delete Selected — Check messages —» [Finish]
— YES

I Delete All Messages
> —> Server Mail = Delete All - Enter Phone Password — YES

P ecccccccccccccccccccoe

@Mail Security (¥P.12-11)
@Server Mail Functions (C3P.14-16)

buibessa\ ;
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I Retrieving/Viewing Messages

Manually Retrieving New Messages

Retrieve S! Mail messages saved on Server while handset is off/out-of-range.

> —> Retrieve New
Server Mail Functions

(From p » Server Mail

M Forward Server Mail

> Retrieve Mail List — Highlight an S! Mail & (3)[Menu] =
Fwd Server Mail = Select Address field = Search/enter address —
Select an address or enter directly & (=)[Send]

® To forward Server Mail from S! Mail Notice: In Message list, highlight an
S! Mail Notice = [Menu] = Forward = Fwd Server Mail -
<Add Address> —> Select/enter an address = (=) [Send]

® Forwarded S! Mail messages are not deleted from Server Mail List.

® -5 appears for Server Mail saved to Drafts or Sent/Unsent box after
forwarded.

W Sort Server Mail
> Retrieve Mail List & (x7)[Menu] = Sort — Select a condition

M View Server Mail Information
> Retrieve Mail List — Highlight an S! Mail & (7)[Menu] =
Mail Information

I View Server Mail Memory
> Server Mail Memory

14-16

Organizing/Using Messages
IChecking Messages in Messaging Folders

® At time of purchase, information messages are provided for your
convenience (Transmission fee does not apply).

— Incoming Mail, Drafts
or Sent/Unsent

® (2] appears for unread messages in
Incoming Mail box.
1 appears for drafts or unsent
messages in Drafts or Sent/Unsent box.

® |n Incoming Mail or Sent/Unsent box,
select a folder.

® Messaging Folders: C%P.14-2

Messaging
o, Incoming Mai |
= (reate New
= Retrieve New
’ Drafts

S Server Mail

= Create New SMS
= Settings

= Memory Status

7 Select a message e
® To show previous/next message in Received/Sent Message window:

(=]

P eccccccccccccocccccccoe

@Functions Available in Incoming Mail or Sent/Unsent Box
@Functions Available from Message List ((3P.14-21)



I Setting Filters (Auto-sort)

Filter messages into folders by criteria.

® Previously sent/received messages are not filtered.

® When a message meets multiple criteria, message is filtered according to
following priority:
Subject = Address — Mail Group —» Phone Book group

® Set multiple criteria per folder (any combination of Subject, address, mail
group and Phone Book group).

® Set up to 30 criteria per folder.

1 —» Incoming Mail or Sent/Unsent

9 Highlight a folder — (37)[Menu]
Auto-sort Setting

3 [Menu] = Select an item (See below)

Item Operation/Description

Add Subject Filter messages by subject
> Enter a subject

® SMS cannot be sorted by subject.

Add Address Filter messages by address
> Search/enter address — Select/enter an address
Add Group  Filter messages by Phone Book group
> Select a group
Add Mail Filter messages by Mail Group
group > Select a Mail Group

M Edit Sort Conditions
> After Step 2, highlight a condition — (@)[Edit] — Edit subject, address,
Phone Book group or Mail Group

I Change Auto-sort Setting List View
> Switch to Name view or Address/Phone number view for Address
conditions.

> After Step 2, (¥7)[Menu] = Address Display = Name or Address

M Delete Sort Conditions
> After Step 2, (highlight a condition —») (7)[Menu] = Delete or
Delete All (= For Delete All, enter Phone Password) = YES

M Re-sort Messages

> To re-sort messages in a specific folder: In Step 2, highlight a folder =
[Menu] — Re-sort in This — YES

> To re-sort messages in all folders: After Step 1, (7)[Menu] — Sort in
All -+ YES

buibessa\ ;
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I Filter Spam

Sort messages from unknown senders into Spam Folder
without incoming notification. Use Safe List to receive
messages from certain addresses, phone numbers or
domains.

® Messages from secret Phone Book entries may be sorted into Spam
Folder. Be careful when deleting messages from Spam Folder.

Setting Spam Folder

<Default> OFF

—> Settings —» Universal Settings —
Anti-Spam Measures

2 Spam Filter = Enter Phone Password

3 ON — YES

14-18

Safe List

® Specify up to 20 addresses and domains (for example, @softbank.ne.jp)
to receive messages from without sorting into Spam Folder.
— Settings — Universal Settings —
Anti-Spam Measures —» Safe List

Add Addresses

[Menu] = Add Address = Received Address
or Direct Entry — Select or enter an address

Add Domains

(x7)[Menu] & Add Domain — Enter a domain

3 ([©@[Finish]

M Edit Saved Addresses
> After Step 1, highlight an address = (@)[Edit] — Edit address

M Delete Addresses

> After Step 1, (highlight an address —») () [Menu] —» Delete or
Delete All (- For Delete All, enter Phone Password) = YES

P eccccccccccccocccccccoe
@Report Received Mail as Spam ((5P.14-24)



I Replying to Messages

Reply mail

1 InMessage window, (&) [Reply]

Received message text is quoted.

® Re: appears before the subject when
replying to S! Mail.

@ Replying to S! Mail with multiple
recipients: In Message window,
(=)[Reply] = Reply to Sender or
Reply to All

Long time no see. How
are you doing?

1 am fine as usual.
By the way. can we
have lunch together
ithis Saturday?

otal size: 420 Bytes|

2 Complete message — (=)[Send]

M Reply without Quoting

> In Message window, (7)[Menu] — Reply — Reply to Sender or
Reply to All & Compose S! Mail or Compose SMS — Compose a
message = (&) [Send]

® Selectable items differ by mail type.

® Alternatively, reply from Message List window without opening
messages (C¥P.14-21).

JifPececcccccccccccccccccece
ETID @Set Whether to Quote Original Message in Reply (C3P.17-18)

I Using Mail Groups

Save mail addresses by group. Messages can be sent to
specified group of recipients.

@ Save up to 20 recipients per group.

® Create up to 20 groups.

Creating Mail Groups

Main Menu » Phone ) Settings » Mail Group

Mail grnup 1/2

1 Selectagroup

i
Group 2

il Group 3

il Group 4

il Group 5

il Group 6

il Group 7

Enter Mail Address Directly
Highlight <Not stored> —
[Edit] — Enter mail address

Select Mail Address from Phone
Book or Sent/Received Address Logs
Highlight <Not stored> —»
[Menu] = Look-up address Selict

— Select an item —» Select an entry  Mail Group List
— (@)[Select] (For Phone Book,

select a mail address)

® Repeat Step 2 to save mail addresses.

il Group 8
il Group 9
il Group 10
il Group 11
il Group 12
il Group 13

buibessa\ ;

14-19



buibessa\ ;

I Change Group Names
> In Step 1, highlight a Mail Group —» (37)[Menu] =
Edit group name —» Edit name

¥ Reset Group Names
> In Step 1, highlight a Mail Group = (37)[Menu] -
Reset group name — YES

M Edit Mail Addresses
> After Step 1, highlight a mail address —» (=) [Edit] — Edit

M Delete Saved Mail Addresses

> After Step 1, (highlight a mail address —) (37)[Menu] —»
Delete this or Delete all (= For Delete all, enter Phone Password) =
YES

[ Send a Message to All Group Members

> In Step 1, highlight a Mail Group — (=) [[IE-M]
® To select a Mail Group from S! Mail Composition window: £5P.14-8
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I Sent/Received Address

> Sent address logs: Press and hold (c) — Highlight a log —
(37)[Menu] —» Select an item (See below)

> Received address logs: Press and hold f2) = Highlight a log =
(x7)[Menu] = Select an item (See below)

Item Operation/Description

Character
size

Toggle font sizes

Add to Phone Save mail address/phone number of log to Phone Book

Book (5 From Step 2 on P4-5)

Add shortcut Create shortcut (C3P.1-20) Select shortcut in Standby

icon to open Composition window with mail address/phone
number of log in Address field

Compose Create and send S! Mail to mail address/phone number

S! Mail of log (% From Step 4 on P.14-4)

Compose Create and send SMS to phone number of log (3 From

SMS Step 4 on P.14-8)

Dialing > Select a dialing method —» Dial

Dialed calls' Show Redial logs

Received Show Incoming Call Logs

calls?

Delete this > YES

Delete > Check logs = (=)[Finish] - YES

selected

Delete all > Enter Phone Password —» YES

' Sent address logs only
? Received address logs only



I Organizing Messages

M Functions Available in Incoming Mail or Sent/Unsent Box
> —» Incoming Mail or Sent/Unsent — (Highlight a folder —)
(37)[Menu] = Select an item (See below)

M Functions Available from Message List
> —> Incoming Mail, Drafts or Sent/Unsent (— Select a folder) =
Highlight a message — (37)[Menu] — Select an item (See below)

Item

Operation/Description

Edit'

Edit message to send
(S! Mail: % From Step 2 on P.14-4/SMS: L& From Step 2
on P.14-7)

Send’

Send draft

Retrieve’

Retrieve complete S! Mail
> This one or Selected (— For Selected, check
messages — ()[Finish] = YES)

Item Operation/Description
Add folder  Add up to 10 user folders to each of Incoming Mail and
Sent/Unsent boxes
> Enter folder name
Edit folder > Edit folder name
name*
Auto-sort Sort messages (C3From Step 3 on P.14-17)
Setting*
Re-sort in Re-sort messages in selected folder
This > YES
Sort in All Re-sort messages in all folders
> YES

Reply?

Reply without quoting message

> Reply to Sender or Reply to All = Select an item
—» Compose a message (S! Mail:Z%From Step 4 on
P.14-4/ SMS: &% From Step 4 on P.14-8)

® Selectable items differ by mail type.

Sort folder*

Sort user folders
> Select a target location

Mail Security

Set to require Phone Password for opening folder
> Enter Phone Password
® To cancel: repeat the step

Reply with
Quote’

Quote received message to reply

> Reply to Sender or Reply to All = Select an item
—» Compose a message (S! Mail: 5 From Step 4 on
P.14-4/SMS: CFrom Step 4 on P.14-8)

® Selectable items differ by mail type.

Delete folder* > Enter Phone Password = YES

* 1—H—T %)% only

W/ NextPage 4
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Item

Operation/Description

Item Operation/Description

Forward®

> Forward or Fwd Server Mail — Select Address field
—» Search/enter address —» Select an address or enter
directly & (=)[Send]

® Forward Server Mail (C3P.14-16)

® When forwarding S! Mail, Fw: appears before the
subject. Dotted line appears in the first line of Text
field.

® Attachments are also forwarded (Messages with copy
protected attachments may not be forwardable).

Mail history'?

Show up to 1000 sent/received mail records

> Select a sender/recipient address

° (sent) or f;- (received) appears.

® Select a record to show Message window. Press
to return to previous window.

buibessa\ ;

Dial > Select an item —» Make a call/compose a message/add
to Phone Book
Add Save address to Phone Book
Address'® > Select phone number or mail address = YES
(5 From Step 2 on P4-5)
Protect/ Protect messages

Unprotect'®

> This one or Selected (— For Selected, check
messages —» (=) [Finish])

® To unprotect, repeat the step.

® SMS saved in USIM Card cannot be protected but are
not auto-deleted.

Move'®

Move messages to another folder

> Move This or Move Selected (— For Move Selected,
check messages — (=2)[Finish] = YES) = Select a
folder

@ SMS saved in USIM Card cannot be moved.

14-22

Delete > Select an item — Operate selected item
® [f messages are received while selecting multiple
messages, message deletion may fail.

Confirm View Delivery report

Delivery'

Send Ir data (C%P.11-3)

IC (C%P.11-5)

Transmission

Copy to Copy message to microSD Card

microSD > YES

Copy to USIM/  Copy SMS to USIM Card/handset
Copy to phone® > YES

Move to Move SMS to USIM Card/handset
USIM/Move > YES

to phone’

Mail View detailed information (Subject, From, To, etc.)
Information

Unread/Read® Switch status to unread/read

Release Cancel Auto Resend

Resending'

Sort Change display order

> Select an order

! Sent messages only
? Drafts only
? Received messages only
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I Using Messages Item Operation/Description
Protect/ Protect message
M Functions Available in Received/Sent Message Window Unprotect ® To unprotect, repeat the step.
> In Message Window, (37)[Menu] = Select an item (See below) ® SMS saved in USIM Card cannot be protected but are
- — not auto-deleted.
Item Operation/Description
— - - Move Move message to another folder
Retrieve Retrieve complete S! Mail | fold
= Edit . i > Select a fo der
Edit It message to sen ® SMS saved in USIM Card cannot be moved.
(S! Mail: C5From Step 2 on P.14-4/SMS: CFrom Step 2 - -
on P.14-7) Delete > Select an item —» Operate selected item
Reply' Reply without quoting message go?flrmz View Delivery report
> Reply to Sender or Reply to All — Select an item elivery
— Compose a message (S! Mail: C5From Step 4 on Send Irdata  (C¥P11-3)
P.14-4/SMS: C%From Step 4 on P.14-8) L (= A )
® Selectable items differ by mail type. Transmission
Reply with  Quote received message to reply Copy to Copy message to microSD Card
Quote' > Reply to Sender or Reply to All - Select an item microSD > YES
—> Compose a message (S! Mail: C3From Step 4 on Copy to Copy SMS to USIM Card/handset
P.14-4/SMS: C5From Step 4 on P.14-8) USIM/Copy to > YES
® Selectable items differ by mail type. phone'
Forward' > Forward or Fwd Server Mail Move to Move SMS to USIM Card/handset
® Forward Server Mail (C3P.14-16) USIM/Move > YES
Mail history  Show up to 1000 sent/received mail records to phone'
> Select a sender/recipient address Mail View detailed information (Subject, From, To, etc.)
® [ (sent) or ;- (received) appears. Information
® Select a record to show Message window. Press Release Cancel Auto Resend
to return to previous window. Resending?
Dial > Select an item — Make a call/compose a message/add |~ Add to Phone Save highlighted phone number/mail address to Phone
to Phone Book Book Book
Add Address Save address to Phone Book > YES (C5From Step 2 on P4-5)

> Select phone number or mail address — YES
(From Step 2 on P.4-5)

Attached files Show attached files

W/ NextPage 4
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Item

Operation/Description

Save
Templates

Save edited templates
> YES

Add Shortcut
Icon

Create shortcut (C%P.1-20) Select shortcut in Standby
to open Composition window with mail address/phone
number in Address field

Copy Copy text, subject or address

Select an item —» Copy (C3From Step 2 on P.3-10)
Font Size > Select a size
Scroll Unit  Change scroll unit

> Select an item
Charset Convert characters when not properly shown
Conversion' > Select an item
Report Spam' Report received mail as Spam

> (=)[Send]

® Change destination to report to if only required
(P.17-18)

! Received messages only

buibessa\ ;
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